
HEADQUARTERS, DEPARTMENT OF THE

ARMED FORCES



EVILUTION

THT: Evilution
Though all the top management of the UAC were dead, as were most

of their personnel down to the janitors, the corporation survived,
but now under strict government supervision. The UAC still sought the
secret to matter apportation and continued its experiments under
vastly increased safety measures.

The UAC’s base was set up on one of the moons of Jupiter, hoping
that the increased distance would enhance Earth’s safety if something
went wrong. Marines were stationed at the base, ready for anything.

The Invasion
Soon after the UAC opened its first Gate, the minions of Hell made

their first attack. Suddenly, through the Gate flowed spiked, fanged,
dripping techno=terrors. Meat machines flailed their armored limbs
and slavered with bloodlust, seeking soft bleeding manflesh to rend.
But in their seeking, they found only death. The United States Space
Marine Corps was prepared for such an event, and they poured molten
death into the hordes of Hell. More demons massed, hoping to over—
whelm the defenders by their endless numbers. But mass alone was no
match for the marines. Set up in defensive positions around the Gate,
the marines were able to slaughter the monsters by the hundreds, taking
few losses.

As suddenly as it had begun, the invasion ended. The last flaming
skull screamed through, was hit by 20 simultaneous shotgun blasts,
and the chamber was silent once more except for the dripping of blood.
Hell had failed.

The research went on, more boldly, and less cautiously. All the
marines received the Silver Star from a grateful government, and the



UAC made an enormous contribution to the Veterans’ Fund. The defensive
positions were strengthened, and the marines watched closely for another
attempt, all their attention drawn inward toward the Gates. They were
looking in the wrong direction.

TheRainof Monsters
Hell knew more than one trick. Months after the Gate incident, the

yearly supply ship came ahead of time. On radar, the ship looked far
larger than usual. And it was coming from the wrong direction.
Strange, but not inexplicable. The lax radar operators reported the
ship’s approach, and personnel went out to the landing field to meet
it. But it never landed. Instead, it hovered over the base, miles in
the air. The men and women looked up at it and saw that something was
terribly wrong.

The ship could not have come from Earth. It was huge, kilometers
long, and was built of bone, steel, flesh, corruption, and death. It was
a bio=mechano-magical construct from the depths of Hell, and it had
come through space for its vengeance. Enormous doors, large as football
fields, suddenly opened, and hideous demons poured out, plunging to the
ground and blanketing the entire base with their throbbing, pulsing
bodies. They were everywhere at once. The marines’ defenses, set up
to prevent an attack from the direction of the Gate, were worthless.
The monsters poured through the sewers, the air vents, the hallways,
everywhere, rampaging, corrupting, and feasting.

Once more, the surviving humans were left as zombified brain-dead
monstrosities. Existing only to kill and kill and kill.
It’s Up To You

Only one man escaped death or zombification. The marine commander.
You. You weren't at the base when the skies opened and devastation

poured from the stars. You were miles away, enjoying a walk across the
moon’s rough=hewn landscape. Then you heard a snorting gurgle behind
you, and you whirled to face one of Them. The beings that still haunted
your nightmares. Your reflexes weren't dulled by your experiences, and
you pulled out your pistol and blew the imp to gory shreds.

Hotfooting it back to the base, you saw it all and realized in a
flash what had happened. The demon ship still floated above the infested
base. Your boys — the men you’d trained to fight and kill and die as
no fighting man had ever been trained before — were dead. You were not
there when it happened, to die with them.

Unlike the ancient samurai, who chose to die with their men, you
cocked your pistol. You were going to kill for your men. And if you died
trying, well, you were going to die anyway, some day. Death at the fangs
of demons might be the very worst way to die, but if they did manage
to get you, Hell would know it had been in a fight.

PLUTORIA

THE PLUTONIA EXPERIMENT
After Hell’s catastrophic invasion of Earth, the United States

took steps to prevent such an invasion from recurring. The old UAC

corporation was refounded, under completely new management (because
the old trustees and stockholders were all dead, this wasn’t much of
a problem), and set out to research new tools and technologies. Though
the invasion had been stopped and the remaining demons were gradually
being exterminated by mopping=up squads, it was clear that the powers
of Hell remained strong. While the Spider Mastermind and Baphomet
seemed to no longer threaten, who knew what else lay Outside? Waiting.
Watching. Preparing.



The new UAC began working on Quantum Accelerator Devices, intended
to close interdimensional Gates at a distance and so prevent future
incursions forever. The project began innocently enough. Faturally, the
scientists, in order to learn how to close Gates, had to relearn Gate
technology first. This ability was rapidly regained. Perhaps too rapidly.
The Terror

Soon beings from Outside had their dire attention drawn to the new
experiments, and then one day, a Gate opened in the heart of the
research complex. Unnatural horrors from the pit poured in, ravening
and destroying. But the UAC scientists had learned their trade. The
Quantum Accelerator Device performed perfectly in its maiden test —

the invasion Gate was closed instantly and permanently when the
Accelerator flicked on. A cyberdemon, halfway through, was snipped in
two when the Gate closed. Earth would now be safe from literal invasion
by Hell. At least once the technology could be set up around the globe.

The next day, a ring of seven Gates opened throughout the base,
and a monstrous legion rampaged through. The Quantum Accelerator began
putting out the Gates at once, and within an hour, six were closed.
But the Hellish army was now too strong, too numerous. The marines
fought like mad dogs but were finally pulled down by the enemies’ claws.
The scientists, marines, and bureaucrats were all slain or transformed
into undead mankillers.

The Task
The Quantum Accelerator and its prototypes are deep inside the

ravaged complex. A demon Gatekeeper guards them and mans the last
Gate of Hell. The government, frantic that the Quantum Accelerator
will be destroyed or used in some alien fashion upon us, has ordered
all marines to the site at once, regardless of their location.

You were on leave at the beach, only a few minutes from the complex,
when you got the word. You suited up, grabbed a pistol, and raced your
pickup truck to the complex. When you arrived, flashes of light,
howls, and chanting could be heard from the interior. Corpses were
scattered everywhere. Obviously the Gatekeeper was doing something
inside — something that would soon reach some kind of awful climax.

You know that within an hour or two, an entire division of marines
will arrive to assault the base with full artillery and air support.
You also know that they will be too late. Far too late. The airplanes
will be plucked from the sky by floating terrors, the cannons melted
by diabolic rockets and fireballs, the soldiers blasted to shreds as
they charge into the armored shell of the UAC buildings. In an hour
or two, the monstrosities inside will have finished their awful task
and will be prepared, once more, to take on the world.

It’s up to you. You have to enter the complex and stop the
Gatekeeper. Alone.

Welcome to Final DOOM, a lightning-fast virtual reality adven=—

ture where you are the toughest space trooper ever to
suck vacuum. Your mission is to fight your way through
the demon-infested Earth in the hopes of saving the Earth
from an eternity in Hell.

The game play for Final DOOM is simple. This isn’t a
cumbersome adventure game but an action-oriented slugathon
instead. To survive, all you need are brains and a killer
instinct.



USIEG THE FIRALDOOM MENU
When you run Final DOOM, the game will begin in single=player mode.

To access the game’s options, hold down the ‘s’ key for the Final
DOOM Single Player Setup dialog, or the ‘m’ key for the Final DOOM

Multiplayer Setup dialog.
Single player and multiplayer setups allow you to load additional

WAD files or a saved game as well as choose the skill level, kill other
applications, and choose other options. The “Turbo” option accelerates
movement and accepts a value ranging from 10 to 255 (normal speed is
100). Press the “Load WAD file” or “Load Game...” button while holding
down the Option key to unload the current additional WAD files or
saved game; multiplayer setup also allows you to configure and start
a multiplayer game. See the Multiplayer Addendum for details on starting
a multiplayer game.

After the game starts, a self-running demo will also begin. At this
point, you can access the menu bar by moving the cursor to the top of
the screen.

To access the Final DOOM menu, press the Spacebar. Use the arrow
keys to move the skull cursor up and down. If you have selected either
Mouse or Joystick under the Options menu, you can also use the mouse
or joystick to move the cursor. When the skull is adjacent to a desired
selection, press Return, Enter, the mouse button, or the joystick Fire
button to activate that selection.

If you're in a game, you can bring up the Menu at any time by
pressing the Escape key. Many of the Menu options can be activated
directly by using a function key, thus bypassing the menus entirely.
To exit the Menu, press the Escape key, or to return to the previous
Mermu from a Submenu, press the Backspace key.

If you want to jump into the action, select this. Final DOOM will
ask you to set the difficulty level. Each difficulty level differs in
the toughness of the enemies you'll face. Beware the Nightmare level of
difficulty. It is definitely not suitable for inexperienced game players.

LOADING ARDSAVING YOURGAME(F2AND F3)
Games can be saved or loaded at any time during game play. To save a

game, enter the name of the game (the default name contains the episode
and map/level number), and click the Save button. To load a game, select
the appropriate game from the Load Game mermu. You can also switch to
the Pinder (unless you've “killed” it) and double-click a saved game
file to load a game, or select Open Saved Game from the File menu.

QUICKSAVE: Pressing the function key F6 or selecting “Save” from the
File menu allows you to save a game without leaving the action. If
you have already saved a game, that file is overwritten when you
select Save; otherwise, the standard file naming dialog will appear.
Pressing F9 (or Command-9) or selecting Quickload from the File memu
loads the last saved game.



QUIT GAME (F10)
Quit Game enables you to quit from Final DOOM and return to the Finder.

You can also press Command=Q or F1lO0, or select Quit from the File mer.
END GAME (F7)

This allows you to end the current game without exiting to the
Finder or loading a new game. You can also press F7 or Command=7 to
end your current game, or select End Game from the File menu.

MESSAGES (F8)
In Final DOOM, whenever you pick up an item, you’ll receive informa=

tion about the thing you just picked up. This option lets you toggle Final
DOOM’s messages on and off. You can also press F8 or Command=-8 to toggle
messages on and off, or select Toggle Messages from the Control meru.

GRAPHIC DETAIL (F5)
The default setting for the screen detail is LOW. If you have a

Power Macintosh or a fast 68040-based Mac, you may wish to select
MEDIUM or HIGH resolution. You can also select Graphic Detail from the
Control menu. If messages are turned on, the current resolution will
be displayed momentarily in the upper left cormer of the screen.
SCREEN SIZE (+ and =)

Just below this option is a bar with a sliding marker. When this
option is selected, you can use the arrow keys to slide the marker
back and forth to adjust the viewing area. A smaller viewing area
increases the smoothness of the animation on slower systems. While
playing the game, you can adjust the size by pressing “=” or “+” on
the main keyboard (note that you do not have to hold down the Shift
key). Pressing the “=” or “+” on the numeric keypad will not work.

SMALL/LARGE GRAPHICS
These options allow you to change the size of the graphics on your

monitor. You may want to use the “Small Graphics” setting to improve
performance.

SOUND VOLUME (F4)
This selection also has a bar with a sliding marker, allowing

adjustment of the volume from “off” to “maximum.” This bar modifies the
music as well as the sound effects volume. Pressing F4 or Command=4
will display these volume settings directly. You must also set the lac’s
overall volume throughout its Control Panel.

MOUSE SENSITIVITY
This selection lets you adjust the sensitivity of your mouse

control. Just below this option is a bar with a sliding marker. When

this option is selected, you can use the arrow keys to slide the
marker back and forth to adjust the sensitivity of the mouse. Note
also that by selecting “Turbo” from the Options menu will adjust the
speed of your movement while in the game.

GAMMA CORRECTION (F1ll)
On some monitors, Final DOOM may appear too dark. Press function key

Fll to lighten the screen through five different brightness levels.

TIP: Save your game and save it often. When you die, you're back to
the beginning of the level, toting that little pistol again. That ain’t
good, especially after you progress to some of the tougher levels.

ON-SCREEN INFORMATION
Final DOOM provides on-screen information that’s necessary to survive.
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THE STATUS BAR

Le
iT 2 5 4 5 6 7

1. MAIN AMMO: In big fat numbers, you see the number of shots
you've got left in the weapon you're currently using.

2. HEALTH: You start out at 100%, but you won't stay there long.
At 0% it’s time to start over. Try a little harder next time!

3. ARMS: This list of numbers shows which weapons are available.
If a number is highlighted, the weapon is accessible by pressing
that number. (“1” is always available.)
4. YOUR MUG: This portrait isn’t just for looks. When you're hit,
your face looks in the direction from which the damage came, telling
you which direction to return fire. Also, as you take damage, you'll
begin to look like raw hamburger — as shown to the right.

5. ARMOR: Your armor helps you out as long as it lasts. Keep an
eye on it because when it goes, you might too.

6. KEY CARDS: You can see any keys you possess right here. There
are three key colors: yellow, red, and blue.

7. AMMO: This shows how much of each type of ammo you're carrying
and the maximum amount you could carry — if you had it.

MESSAGES
Often you'll find yourself running over various items. Final DOOM

tells you what you're picking up by printing a message on the screen —

unless messages are off. Pressing RETURN will display the last message.

THE AUTOMAP
To help you find your way around Final DOOM, you're equipped with an

Automap device. By pressing the Tab key, you replace your normal view
with a top-down map of everything you've seen up-to-date. The white
arrow represents you and points in the direction you're looking. You can
goom in and out by pressing “+” or “=". Press the number “0” to toggle
between zoom and full view. To mark your location on the map, press
the “NU” key. This will place a mumber over your location. To clear all
the numbers from the map, press the “C” key.

MOVING IR THE AUTOMAP

Using the arrow keys, you can move
yourself while viewing the Automap. This is
dangerous because you can’t see the enemy
while viewing the Automap. To scroll the
Automap without moving yourself, turn off

5 ok : : Follow mode. Pressing the “F” key willEel toggle Follow mode on and off.

CONTROLLING THE ACTION
Most of the play commands in Final DOOM are a simple key press

away. You can use either your keyboard, mouse, joystick, or combinations
of both to move, pick up items, shoot, and open doors.

11
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MOVING
At first, you might find yourself bumping into walls while demons

beat on you. Once you've got movement down, everything else follows.
WALKING: Use the up and down keys to walk forward/backward.
TURNING: The left and right keys turn you left and right.
RUNNING: Hold down the run key and the appropriate movement key
to speed yourself up.
STRAFE: By holding down the Alt key and the right or left arrow key,
you can sidestep rather than turn left or right.

Note: Jumping is very important for successfully completing Final DOOM.

Though there is no Jump Key, you can leap from ledges by getting a
running start. The faster you are moving, the farther you will go.

TIP: When traveling narrow passages, many players have found it useful
to examine the Automap in a magnified mode, enabling them to see exactly
where to step.
JOYSTICK OR MOUSE: A number of “settings” files for various Macintosh=
compatible joysticks will be installed in your FINAL DOOM folder, allow=
ing you to configure your joysticks for your own preferences. Note
that if the Mouse or Joystick is enabled, the menu bar is disabled.
To access the menus, press Command-K (Keyboard mode), or press the
Command-key equivalent of the memu you want (e.g., Command-S to Save).
Moving the cursor to the top of the screen while in keyboard mode
displays the menu bar.

PICKING UP STUFF
To pick up an object, just walk over it. You're smart, and you know

if you need to take it.

USING DOORS, SWITCHES & ELEVATORS
To open most doors and operate switches, stand directly in front

of them and press the Spacebar (or other key if you changed the “Action”
key setting). When you successfully operate a switch, it will change
in some way (lights up, flips a handle, etc.). If a switch does not
change after a couple of tries, it is probably assigned to do a task
that cannot yet be accomplished.

# have a color-coded (yellow, red, and blue) security card or skull
key to open them. Other locked doors are operated by a switch on a= nearby wall. Rather than walking up to the door, you’'11 need to
operate the switch.

LOCKED DOORS: Some doors have security locks and require you to

HIDDEN DOORS: Some doors are hidden. Many of these can be opened by
finding a switch. In some cases you just need to walk up to the wall
and press the Spacebar/Action key. If you've found a secret door, it
will open for you. There are clues that reveal a secret door — a wall
that’s shifted down or is a different color, a flashing light on a
wall, etc.
ELEVATORS: You'll see platforms that raise and lower. Some platforms
operate continuously while others must be activated. Some of them sense
your proximity and lower automatically. Others have a nearby switch.
Those without a switch can usually be operated by walking up to the
platform and pressing the Spacebar/Action key.

TELEPORTERS: Teleporters can be identified by an evil symbol on the
floor beneath them. To use a teleporter, walk over the symbol.

13



COMPLETIEG AN AREA
At the end of each area in Final DOOM, there is an exit chamber.

Enter this chamber and press the switch inside to exit the area and
head onward. When you finish an area, an Achievement Screen tallies
your performance. Hidden regions located, ratio of kills, percentage
of treasure found, your completion time, and a par completion time
are all displayed.
ETERNAL LIFE AFTER DEATH

If you die, you restart the level at the beginning with a pistol
and some bullets. You have no “lives” limit — you can keep restarting
the level as often as you're killed. The entire level is restarted
from scratch too. Monsters you killed before are back again, just like
you.

FIREPOWER ARD HOW TO USE IT

WEAPONS: At first, you have only your pistol and your fists for pro-
tection. When you run over a new weapon, you'll automatically equip
yourself with it. As the game progresses, you'll need to choose between
firearms. The numeric keys select particular weapons (you cannot use

the keypad keys for this selection). The weapons are:

aban 1 = Fist/Chain Saw 2 = Pistol
Note: When you walk across the chain saw, it replaces
your fist as the current weapon.RP——— 3 = Shotguns/Combat Shotguns can deliver a heavy punch
at close range and a generous pelting from a distance.

Combat Shotguns are double-barreled, sawed=—off
killing sticks. These gats are the ultimate in pellet
warfare. Beware: Two barrels not only deliver more
firepower but also take more time to reload. Pressing
the “3” key will toggle between the Shotgun and the
Combat Shotgun.

4 = Chainguns direct heavy firepower into your opponent,
making him do the chaingun cha=cha.

5 = Rocket Launchers deliver an explosive rocket that
can turn several baddies inside out.

6 = Plasma Rifles shoot multiple rounds of plasma
energy — frying some demon butt!

7 = BPG 9000s are the prize of the military’s arsenal.
Great for clearing the room of those unwelcome guests.
Shoot it and see for yourself.

fill)

PIRING: To use a weapon, point it toward the enemy and press the “D”
key (or other key if you have changed the Fire key in the Preferences
dialog), or hold it down for rapid fire. If your shots hit a bad guy,
you'll see splattering blood. Don’t worry if the enemy is higher or
lower than you. If you can see a monster, you can shoot it.



AMMO: Different weapons use different types of ammo. When you run
over ammo, Final DOOM automatically loads the correct weapon.

Small Ammo

Clip i
Shells BEES

Rocket AoiYou have a maximum limit on the amount of ammo you can carry too.
These are listed on the right side of your status bar. Also, when you
find a weapon that you already possess, don’t scorn it! Picking it up
also gives you ammo.

Large Ammo Weapon

Ammo Box Pistol, Chaingun

Box of Shells Shotgun

Rocket Case Rocket Launcher

Bulk Cell Plasma Rifle,
BFG 9000

COMMANDS ARD SHORTCUTS
Keyboard
Command-P = Pause
Esc Key = Menu
Tab = Automap (on/off)

Menu/Item
Control/Pause

Keyboard Menu/Item
Fl or Command-l=Help Control/Help
F2 or Command-S=Save File/Save
F3 or Command-0=Load File/Open Saved Game

F4 or Command-4
F5 or Command=5
F6 or Command-S
F7 or Command-7
F8 or Command-8
F9 or Command-9
Command=Q = Quit
Command=G = Gamma Correction
= = Reduce View
+ = Increase View

Control/Sound Volume
Control/Graphic Detail

Sound Volume
Graphic Detail
Quicksave File/Save
End Game File/End Game

Toggle Messages Control/Toggle Messages
Quickload File/Quickload

File/Quit
Control/Adjust Gamma

Command=-K = Keyboard/Access lernu bar
Command-M = Mouse enabled (no memu bar access, mouse cursor is hidden)
Command=-J = Joystick enabled (no memu bar access, mouse cursor is hidden)

COMMANDS USED ORLY IN AUTOMAP
F = Follow mode (on/off) u
+ = Zoom in - = Zoom out O

Mark place= C = Clear Marks
= Full map/Zoom

WEAPONS SELECTION
1 = Fist/Chain Saw 2 = Pistol 3 = Shotgun/Combat Shotgun
4 = Chaingun 5 = Rocket Launcher
6 = Plasma Rifle 7 = BFG 9000

MOVEMENT KEYS (Default Setting)
Move Forward = I
Move Backward = K

Run Forward = Shift + I
Run Backward = Shift + K
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Turn Left Fast Right Turn = Shift + L
Turn Right = L Strafe Left = U (or Opt + J)
Fast Left Turn = Shift + J Strafe Right = 0 (or Opt + IL)

FIRING YOUR WEAPON (Default Setting)
D Key
Mouse Button
Joystick Button

OPENING DOORS/FLIP SWITCHES (Default Setting)
Spacebar

TIP: When you're comfortable playing the game, try using the keyboard
and the mouse simultaneously. The mouse provides fine control for
aiming your weapon (allowing you to smoothly rotate right and left)
while the keyboard permits you to activate the many useful functions
of the game.

DANGEROUS FIRAL DOOMENVIRONMERT
Some parts of the Final DOOM environment can be more dangerous

than the monsters you'll face. Areas containing exploding barrels,
radioactive waste, or crushing ceilings should be approached with
caution.

EXPLODING BARRELS: Scattered around the base are drums con—
taining fuel, toxic waste, or some other volatile substance.
If your shots hit one of these barrels, it’s kablooey time!
It might take several bullets to set off a barrel, but a single
blast of any of the other weapons usually does the trick.

SLIME AND OTHER RADIOACTIVE WASTE: Many of the areas in Final DOOM

contain pools of dangerous liquids that will damage you if you walk
through them. There are several varieties of waste, each doing an
increasing amount of damage. If it looks fluid, beware!

CRUSHING CEILINGS: Some of the ceilings in Final DOOM can smash you,
making you cry blood. Often you'll be able to see the ceiling moving
before you go under it, but not always. Be careful and Save often!

TIP: Barrels can often be the most devastating weapon in your arsenal —

delivering a body-blasting explosion to all nearby purgatory pedestrians.
Wait until several evil guys get next to a barrel and blast away at
the can. Then watch ‘em all go boom!

HEALTH AND ARMOR
Even for a tough hombre like you, Final DOOM can be a deadly place.

Whenever you are injured, the screen will flash red, and your health
will decrease. Keep an eye on your health or you'll end up face down.

HEALING: When you're hurt, you'll want to get your health back as
soon as possible. Fortunately, Medikits and Stimpacks are frequently
scattered around the base. Grab them if possible.

Stimpacks give you a quick injection of booster enzymes that
make you feel like a new man — at least to a degree.

Medikits are even better and include bandages, antitoxins,
and other medical supplies to make you feel a lot healthier.

ARMOR: Two types of body armor can be found lying around. Both reduce



damage done to you. Unfortunately, both deteriorate with use and
eventually are destroyed by enemy attacks, leaving you in need
of replacement armor.

Security armor is a lightweight Kevlar vest that’s perfecta2for riot control.
Combat armor is a heavy-duty jacket composed of a titanium
derivative — useful for protection against real firepower
like the kind you're gonna face.

If you're wearing armor, you only pick up a replacement suit if it
provides more protection than what you're now wearing.

POWER-UPS
Other bits of “challenging electronics” may be found in Final DOOM.

lost of these are pretty doggone handy, so grab them when you're able.
These special items have a duration of either the entire level, a
specific amount of time, or an instant benefit. A few of them affect
your game screen so you can tell when they are active. For example,
when you pick up a radiation suit, the game screen turns green. As the
suit deteriorates, the screen will flash. This is a hint to get out of
the radioactive ooze now!

Radiation Suits provide protection against radioactivity,
heat, and other low-intensity forms of energy. Basically,
these suits enable you to wade through the radioactive ooze
without taking damage. While a suit holds out, your screen
will have a greenish tint.
Duration: Time Based

enormously boosting your muscle power. Because you're already
a pretty meaty guy, this enhanced strength lets you tear

ordinary dolts limb from limb, and you can even splatter those demons
without too much trouble. However, you ve got to use your Fist attack
to get the benefit of the Berserk attack bonus. When you become
Berserk, your screen will briefly turn red.
Duration: One Level

Hair Berserk Packs heal you, plus act as a super-adrenaline rush,

Backpacks increase the amount of ammo you can carry. In
addition, whenever you find a backpack, you receive extra
ammunition.

Computer Maps are a handy find, updating your Automap with a
complete map to the entire area, including all secret or
hidden areas. Areas you haven't been to are mapped in gray.
Duration: One Level

pe Light Amplification Visors allow you to see clearly even in
pitch dark. Duration: Time Based

ARTIFACTS
A few artifacts from the other dimension are now lying around, and

you may want them too.

Health Potions provide a small boost to your health — even
past your normal 100%!

Spiritual Armor provides a little extra protection above and
beyond your normal &rmor.
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Soul Spheres are rarely encountered objects that provide a
large boost to your health. A close encounter with one of
these and you'll feel healthier than ever!

Mega Spheres combine the power of combat armor with the benefits
of a Soul Sphere.

Blur Artifacts are strange orbs that make it difficult for
others to spot you. The enemy can still see you, but most of
their attacks will be less than accurate.
Duration: Time Based

Invulnerability Artifacts render you immune to all damage.
Pretty cool, until the effect wears off. When you're
invulnerable, your screen will be white — your punishment
for being tough.
Duration: Time Based

TIP: Create dissension among demons by maneuvering them into a crossfire.
If a bad guy is hit by another demon, he'll turn his rage toward the
poor jerk with the pitiful aim. If this happens, let 'em at each other —

it’s always best to let the bad guys do the work for you. (This isn't
effective with projectiles fired between demons of the same form.)

THE ENEMY
From the very first moment you enter the door till the last gunshot

of the game, you'll be fighting a host of baddies. Some are just
regular guys with a bad attitude; others are straight from Hell. Some
of the monsters you’ll face aren't shown here. Don’t say we didn’t
warn you.

t1
*

Former Humans: Just a few days ago, you were probably
swapping war stories with one of these guys. Now it’s time
to swap some lead upside their head.

Former Human Sergeants: Same as above, but much meaner
and tougher. These walking shotguns provide you with a few
extra holes if you're not careful!

Former Commando: Geeze, weren't shotgun zombies bad
enough? At least when you fade these jerks, you get a really
cool chaingun.

Imps: You thought an imp was a cute little dude in a red suit
with a pitchfork. Where did these brown bastards come from?
They heave balls o’ fire down your throat and take several
bullets to die. It’s time to find a weapon better than that
pistol if you're going to face more than one of these SOBs.

Demons: Sorta like a shaved gorilla, except with horns, a
big head, lots of teeth, and harder to kill. Don’t get too
close, or they'll rip your friggin’ head off.

Spectres: Great. Just what you needed. An invisible (nearly)
monster.
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a) Lost Souls: Dumb. Tough. Flies. On fire. 'Fuff said.

Cacodemonss They float in the air, belch ball lightning,
and boast one Hell of a big mouth. You're toast if you
get too close to these monstrosities.

Hell Knight: Tough as a dump truck and nearly as big,
these Goliaths are the worst things on two legs since
Tyrannosaurus rexXe

Barons of Hell: The Hell Knight was bad news, but this
is Big Daddy. These bruisers are a lot like Hell Knights,
but they look a little different and are twice as tough
to kill.

Arachnotrons Maybe cybernetics wasn’t such a great idea
after all. Look what the demons have done with it. It
seems unfair somehow that you're not the only guy in Hell
with a plasma gun.

Pain Elemental: What a name. And what a guy. Killing him
is almost as bad as letting him live.

Revenant: Apparently when a demon dies, the others pick
him up, dust him off, wire him with some combat gear, and
send him back into battle. Fo rest for the wicked, eh?
You wish your missiles did what his can do.

Mancubus: The only good thing about fatso is that he’s a
nice wide target. Good thing because it takes a lot of
hits to puncture him. He pumps out fireballs as if there
were no tomorrow.

Arch-Vile: One of the worst of a bad lot. You can’t think
of enough rotten things to say about him. He's fast, hard
to kill, casts spells, and resurrects dead monsters! At
least these suckers are rare.

The Spider Mastermind: You knew the Arachnotrons had to
come from somewhere. Hi, mom. She doesn’t have a plasma
gun, so thank heaven for small favors. Instead, she has
a super-=chaingun. Crap.

The Cyberdemon: A missile-launching skyscraper with goat
legs. Nuff said.
Note: The above illustrations are not drawn to scale.
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